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Introduction       
 

This User guide describes the installation and features of Xerox 
CentreWare for Hewlett Packard OpenView Network Node 
Manager, Version 1x. As an enterprise network management 
application, OpenView provides the ability to view and centrally 
manage network resources.  With the addition of the CentreWare 
snap-in for OpenView NNM, this application can additionally 
provide the status of Xerox devices on the network. 
 
When successfully installed, you will be able to view all of the 
discovered Xerox network devices under one map in OpenView 
NNM. 
 
In addition, CentreWare for HP OpenView NNM enables 
OpenView NNM to: 
 
•  Discover Xerox networked devices with HP OpenView. 
•  Provide special status and notifications to HP OpenView 

NNM users about Xerox devices. Device status will be 
enhanced by a rich MIB data set available via web server in 
certain Xerox networked devices. 

•  Display standard OpenView NNM color coding for the Xerox 
Printer Agent icon. 

•  Automatically notify the user about Xerox device events and 
problems through the use of SNMP event traps. 

•  Launch CentreWare Internet Services using a standard web 
browser. 
NOTE: this assumes all Xerox networked devices will include 
an Embedded Web Server.  
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How to use this 
Document 

 
This document assumes that you have a working knowledge and 
familiarity with HP OpenView NNM. Only procedures that 
result from the installation of the CentreWare for HP OpenView 
NNM snap-in are described. 
 
You may print all or part of this document at any time from your 
Adobe Acrobat reader by clicking the File menu and then 
selecting Print. You may then select a single page, a range of 
pages, or the entire document for printing. 
 

For initial installation 
 
Read and follow this section: 
 
CentreWare for HP OpenView NNM Software Installation 
 

For day-to-day tasks 
 
Read and follow these sections: 
 
Using CentreWare for HP OpenView NNM  
 
Troubleshooting 
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Key Benefits and 
Features 

 

 
 
   Feature  Benefits 

Device Discovery  Provides the automatic identification of Xerox devices on your 
network and presents them with recognizable icons. 

Color-Coded Device Status Automatically changes the color in the device icon to reflect the 
device status in the Xerox Printers map. 

Access to the device embedded web 
server, CentreWare Internet Services 

If your device contains an embedded web server (CentreWare 
Internet Services), you can easily access it by selecting Server 
Home Page under the OpenView Tool s menu Web Browser 
selection. 

Custom Domain for Xerox Devices  Managing the Xerox devices on your network is made much 
easier by displaying all the discovered Xerox devices in a single 
domain. 

SNMP Trap Support  Provides option for registering with Xerox networked devices for 
SNMP Traps automatically, without having to configure each 
device individually. 

 
 

System Requirements  

 

Hardware Requirements 
This solution modifies existing HP OpenView NNM files and 
adds a few small files to your hard disk. The total hardware 
requirements are as follows: 
 
• Pentium PC 
 
• Minimum 64 Megabytes RAM 
 
• Minimum 5 Megabytes Hard Disk Space 



 
 
 
 

Introduction 
 

XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE     ❖          7  

 
 
 

 
 
 
 
 
 
 
 
 

 

 
 

Software Requirements 
The following software must be installed on your PC before 
installing CentreWare for HP OpenView NNM. 
 
• Windows NT 4.0 with Service Pack 3.0 or later 
 
• HP OpenView NNM Version 6.0, or later 
 
• Microsoft Internet Explorer 4.1, or greater –  

OR – Netscape Navigator v4.0 or greater. 
 
 
 
 

Before You Start 
CentreWare for HP 

OpenView NNM 

 
Connect your device to an active network with appropriate 
cabling. Ensure the device has a valid, unique IP address.
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CentreWare for HP OpenView NNM  
Software Installation    

Web Installation  
 
The latest version of CentreWare for HP OpenView NNM is 
available from the Xerox Website at: 
http://www.xerox.com 
 
Perform the following steps to install CentreWare for HP 
OpenView NNM: 
 

1 After downloading the file to a temporary folder, double click on 
the icon to extract the files. 

2 Double click on the file setup.exe. 

3 The software will begin the installation process. After a few 
moments, the Install Shield Wizard will load. 

4 This software must be installed in the same folder that contains the 
HP OpenView software. If the folder shown is incorrect, select the 
Browse button and select the correct folder, then select Next. 

5 Select Next again to begin. The necessary files in your HP 
OpenView environment will be modified and copied to the selected 
folder along with any additional files required. 

6 The installation process will take some time to complete. Follow 
the instructions on your screen. 

7 When the install is complete, start HP OpenView NNM.
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Using CentreWare for HP OpenView NNM
 
 
 
 
 
 
 

The HP OpenView NNM 
Interface 

 
This section describes the features of HP OpenView NNM 
made available by the installation of CentreWare for HP 
OpenView NNM. Only those features of OpenView that are 
directly related to the CentreWare functionality will be 
described. For additional information on HP OpenView NNM, 
go to the OpenView Home page at: 
 
http://www.hp.com 
 
 
An example of the HP OpenView User Interface is shown ion 
the figure below.  Note that the standard features of the 
application are accessed via the Menu bar at the top of the 
display, and the Tool bar situated below it. 
 

 
 
On this display, there are two domains displayed on the “map” 
that is the work space for the OpenView NNM application. Of 
these two domains, only the Xerox Printers domain was 
generated by CentreWare for HP OpenView NNM. 
 
NOTE: The background of the workspace is selectable by the 
user. Not all OpenView installations will utilize a map of the 
United States for their background scheme.
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The CentreWare generated Xerox Printers domain represents 
all of the Xerox devices that were discovered on the network. 
Double clicking this icon will cause these devices to be 
displayed in a map view that shows each Xerox device. 
 
If this icon is right-clicked, a secondary dialog is displayed by 
selecting Xerox Device Display from the resulting menu. The 
dialog is shown below. It is used to provide statistics including 
the number of devices found under the Xerox Printers icon, and 
their status. 
 

 
 

 

Device Discovery  

 
 
 
 
 
HP OpenView NNM provides the discovery of Xerox devices. 
CentreWare for HP OpenView NNM additionally enables the 
identification of these device types as Xerox devices and the 
assignment of a unique Xerox icon to them. 
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Xerox Device Icons  
 
 

 
 
 

 
 
 
 

Xerox Agent Icon 
 

 
CentreWare for HP OpenView NNM uses two icons to 
represent individual Xerox devices.  
The icons for these devices are: 
 
Xerox Printer - This icon represents those devices that are 
printers only. An example might be one of the Xerox N-Series 
printers.  
 
 
 
 
Xerox Multifunctional Device - This icon represents devices 
that have more than just printing capability. The features of 
these devices may include copying, network scanning, and 
faxing. An example of this type of device would be the Xerox 
Document Centre products. 
 
 
 
 
When double-clicked, a Xerox Printer icon or Xerox 
Multifunctional device icon will display another icon called the 
Xerox Printer Agent icon. Like the other icons in HP 
OpenView NNM, this icon will change when the status of the 
device changes. The function of this icon is to monitor alarms 
from the Xerox device and report them to HP OpenView NNM.  
This icon is created when CentreWare for HP OpenView NNM 
is installed.  It is the only icon whose color is controlled by the 
CentreWare snap-in. 
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Device Status 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Device Specific Alarms

 
The Xerox Printer Agent icon will be color-coded to represent 
the current status of the device in the Xerox Printers map. The 
color-coded status for the Xerox Printers map is provided via 
the xrxstatus.dll utility. 
 
The Agent icon in the IP map will not affect the status or 
coloring of the IP map. Therefore the IP map will maintain 
device status as if CentreWare for HP OpenView NNM was not 
installed. 
 
The color of the icon is determined by the return code from the 
device. Under the control of HP OpenView NNM, the color 
will also propagate to the top of the Xerox Printers map, 
providing top level indication of problems that exist at lower 
levels in the map structure.  
This propagation is controlled by HP OpenView NNM, not 
CentreWare for HP OpenView NNM. 
 
The relation between the color-code and the device status is 
presented in the following table. 
 

Xerox Printer Agent Color 

Critical Red 

Warning Light Blue 

Other, or no alert Green 

 
NOTE:  The default propagation rule set used by HP NNM  
will not propagate the most critical error to the actual printer 
icon in the Xerox Printers map.   
 
To set the status propagation at the HP NNM GUI select the  
Map->Properties->[Status Propagation].  Change the setting 
from “Default" to "Propagate Most Critical." 
 
 
To view alarms for a specific device: 
 
Select the device and open it to see the Xerox Agent icon. 
Select the Xerox Agent icon.  
Select the pull down menu. 
Fault->Alarms. 
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Menu Items for Xerox 
Devices 

 
There are a series of OpenView NNM menu items that are 
created when CentreWare for HP OpenView NNM is installed. 
These menu items reside on the Tools menu on the OpenView 
Menu bar. 

Web Browser Menu Item 
Many Xerox devices contain embedded web servers. HP 
OpenView NNM automatically detects whether a device 
contains one and launches CentreWare Internet Services though 
the Server Home Page menu selection. 
 
Internet Services provides a variety of features for configuring 
and monitoring your device. 
 
Consult the manuals and CDs delivered with your device for 
details on Xerox CentreWare Internet Services. The Web 
Browser menu item is used to launch CentreWare Internet 
Services for the selected device. To use this feature perform the 
following steps: 

1 Right click a Xerox device. 

2 Select Server Home Page. 

3 The default web browser for the workstation will be launched, and 
CentreWare Internet Services for the device will be displayed. 
 
NOTE** If the Server Home Page is not available, complete 
the following steps 

. 
 

1 Right click the Xerox device. 

2 Select Object Properties. 

3 In Attributes, select General Attributes. 

4 Click on the Edit Attributes button. 

5 Click on isHTTPSupported 
     The value should change to True. 

6 Click OK. 

7 Click OK. 

8 Right click on Xerox device. 

9 Select Server Home Page. 
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Xerox Trap Registration Menu Items 
 
The Xerox Trap Registration menu item will allow the user to 
select and enable the type of trap configuration desired for the 
managing workstation. Traps are used to provide an alert the 
instant an error at the device occurs, rather than waiting for the 
next status poll. They also provide more detailed 
troubleshooting information when a device is experiencing a 
problem. 
 
There are two possible selections for Trap Registration. With 
Single Selection, the user selects a specific Xerox device. Only 
the device selected will be registered. Any alerts for that device 
will be seen in the managing workstation’s All Alarms 
Browser. 
 
With the Auto Trap Configuration the managing workstation 
is registered at all discovered Xerox networked devices to 
receive traps. As with Single Selection, any alerts for the 
devices are seen in the managing workstation’s All Alarms 
Browser. 

Single Trap Selection Menu 
 
This trap configuration registers the selected device. Only one 
device can be selected at a time. 
 
To use the Single Selection configuration, perform the 
following steps: 

1 Select a Xerox device. 

2 Select the Tools -> Xerox Trap Registration -> Single 
Selection. 

3 The Xerox device will be configured to recognize the managing 
workstation. 

4 The SNMP information for that device will be captured and 
displayed in the All Alarms Browser for the managing workstation. 
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Using Auto Trap Configuration Menu 
 
In the Auto Trap Configuration, all discovered Xerox devices 
are registered. 
To use Auto Trap Configuration, perform the following steps: 

1 Select a Xerox device. 

2 Select the Tools menu, Xerox Trap Registration, and Auto Trap 
Configuration. 

3 The managing workstation will be registered at all discovered and 
managed Xerox networked devices. 

4 The SNMP information for that device will be captured and 
displayed in the All Alarms Browser for the managing workstation. 



 
 
 
 

Using CentreWare for HP OpenView NNM 

16     ❖      XEROX CENTREWARE FOR HP OPENVIEW NNM USER GUIDE 

 
Confirming SNMP Trap Registration at the 
Device 
To confirm SNMP Trap Registration on a specific Xerox 
device, perform the following steps: 
 

1 Right click the Xerox device. 

2 Select Server Home Page. 

3 The default web browser for the workstation will be launched, and 
CentreWare Internet Services for the device will be displayed. 

4 Select the Properties tab. 

5 Select Connectivity, Protocols and SNMP. 

6 The screen below is displayed. 
 
NOTE: The procedure and screen may vary between Xerox 
devices.  If the device supports traps, locate the SNMP 
configuration page for your device.
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NOTE***If the Server Home Page is not available, complete 
the following steps. 
 

1 Right click the Xerox device. 

2 Select Object Properties. 

3 In Attributes, select General Attributes. 

4 Click on the Edit Attributes button. 

5 Click on isHTTPSupported 
     The value should change to True. 

6 Click OK. 

7 Click OK. 

8 Right click the Xerox device. 

9 Select Server Home Page. 

SNMP MIB Browser Menu Item 
 
The Tools -> SNMP MIB Browser selection will display a MIB 
browser that allows the user to search for, select, view, and set 
values for MIB OIDs. 
 
The MIB Browser is a standard feature of the HP OpenView 
application, and is not installed with CentreWare for HP 
OpenView NNM. However, when CentreWare for HP 
OpenView NNM is installed, the OIDs for Xerox networked 
devices are installed, and can be viewed with the SNMP MIB 
Browser. 

 
Using this browser, the user can access any MIB OID in the 
configuration. The browser will then allow the user to view the 
contents of the OID for evaluation and troubleshooting.
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MIBs Loaded During 
Installation

 
In the following table is a list of the MIBs loaded during 
installation of CentreWare for HP OpenView NNM, 
accompanied by a brief description of the MIB. 
 
NOTE: All Xerox devices support a subset of the included MIB 
modules. IETF MIBs are supported by all Xerox devices.

 
 

MIB Name Description   

02common_xrx.mib The root of the Xerox Common MIB module. 

06gentc_xrx.mib  Xerox General Textual Conventions 

07gen_xrx.mib Xerox General MIB 

10hosttc_xrx.mib The TC module for textual conventions, enumerated types, OIDs and other volatile 
elements of the companion Host Resources Extensions MIB ('xcmHrMIB'), which 
supports extended configuration and management of various host resources for 
network accessible host systems. These modules augment and extend the original 
IETF Host Resources MIB (RFC 1514). 

11hostx_xrx.mib  The MIB module for extended configuration and management of various 
host resources for network accessible host systems. This module augments 
and extends the original IETF Host Resources MIB (RFC 1514). 

15prtxtc_xrx.mib  Xerox Printer MIB Extensions Textual Conventions. This Module provides 
Xerox extensions of the IETF Printer MIB. 

16prtx_xrx.mib  Xerox Printer MIB Extensions Module. This Module provides extension to 
the IETF Printer MIB. 

21rsrctc_xrx.mib  XCMI Document Resources MIB Textual Conventions 

22rsrc_xrx.mib Document Resources General Group (Mandatory) 
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40jobtc_xrx.mib  This textual-convention module defines textual conventions for use with 
the Job Monitoring MIB, module: XEROX-JOB-MONITORING-MIB. 
Also the explanatory material with this module explains the Job 
Monitoring MIB. These textual-conventions and explanations are in a 
separate module from the Job Monitoring MIB, so that they may be 
republished when additional enums are added or more explanatory material 
is added without needing to republish the Job Monitoring 
MIB. This increases the stability of the Job Monitoring MIB. 

41jobmon_xrx.mib  This MIB specifies job and document objects for monitoring print jobs, 
including accounting of print jobs. This MIB does not provide for 
management or control of print jobs, such as canceling or modifying them.

42jobmtc_xrx.mib  Textual Conventions companion to the XCMI Simple Job Mgmt MIB. The 
MIB module for performing lightweight management of jobs in network 
accessible host systems.  

43jobman_xrx.mib The MIB module for performing lightweight management of jobs in 
network accessible host systems. 

50commtc_xrx.mib  The TC module supports textual conventions, enumerated types, OIDs, and 
other volatile elements of the companion Communications Engine MIB. 
This allows detailed protocol stack graphing, and active management of 
communications protocol stacks, communications end system applications,
communications intermediate systems, and communications gateways for 
network accessible host systems. 

51comms_xrx.mib The MIB module for detailed protocol stack graphing, and active 
management of communications protocol stacks, communications end 
system applications, communications intermediate systems, and 
communications gateways for network accessible host systems. 

52conftc_xrx.mib The TC module for textual conventions, enumerated types, OIDs, and other 
volatile elements of the companion Communications Config MIB, which 
supports active configuration discovery of communications end system 
applications, communications 
intermediate systems, and communications gateways for network 
accessible host systems. 

53config_xrx.mib  The MIB module which supports active configuration discovery of 
communications protocol stacks, communications end system 
applications, communications intermediate systems, and communications 
gateways for network accessible host systems. 
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58svctc_xrx.mib  Textual Conventions companion to XCMI Service Monitoring MIB, the 
MIB module for basic configuration and active management of application 
services for network accessible host systems. 

59svcmon_xrx.mib  The MIB module for basic configuration and active management of 
application services for network accessible host systems. 

93pidtc_xrx.mib  Product ID Module 

RFC1213  IETF MIB II 

RFC1514  IETF Host Resource MIB 

RFC1759 IETF Printer MIB 

RFC1902,1903,1904 Allows compilation of SNMP v2 format MIBs that were downgraded to V1 
format. 
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Troubleshooting      
 
If you have problems after you have installed CentreWare for HP OpenView NNM, consult the table 
below. 
 

Symptoms Possible Causes Solution 

Installation gives a 
message box reading 
“HP OpenView demand 
level is not set to All 
Levels. Please exit the 
setup, set the demand level 
to All Levels from the NNM 
GUI and then proceed with 
setup process.” and then 
exits. 

The Demand level of the NNM 
application is not set to the 
appropriate value. 

1. Before running the CentreWare install, 
open the NNM GUI. 
2. From the menu bar, click Map-
>Properties. It will open a new window 
named “Map Properties” 
3. Click on the “Applications” tab, select 
IP Map from the List Box and press the 
button labeled “Configure for this map”. 
4. Highlight the field named On-Demand: 
5. Select “All Levels”. 
6. Click the “Verify” button, and upon 
verification, press the “OK” button. 
7. On the “Map Properties” click the “OK”
button. It performs some configuration. 
8. After the NNM completes configuration, 
close the NNM window. 
9. Begin the installation again. 

A Xerox device is not 
discovered. 

The SNMP agent is not working
properly in the node. 
 
There is a problem with the 
network connectivity. 
 
The Network in which the 
Device exists is unmanaged. 

Ping the Xerox device. 
 
 
Ping the Xerox device. 
 
 
Contact the Network Administrator. 

A Xerox device is still not 
discovered. 

The sysObjectId entry in the 
oid_to_sym , or  oid_to_type  is 
missing. 

Make the sysObjectId entries in each file 
using the proper format. 

Icon on the map is not the 
proper Xerox device icon. 

The object’s SysObjectId in the 
file oid_to_sym is not properly 
entered. 

Make the sysObjectId entries in the 
oid_to_sym file in the proper format. 

 
NOTE: Most of the errors generated by the CentreWare for HP OpenView NNM are logged in a log file. 
For more information, look into the log file ("install directory"\Xrx_Device_log.txt). 
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Appendix A – Xerox Installer /  
Un-Installer     

Installer 
 
The installer is a simple Install-Shield application that will 
automate the addition of the files and perform the required 
configuration. 
The installer will copy bitmap images and registration files into 
the HP OpenView installation directory.  It will also edit 
several files to enable the identification of Xerox devices in HP 
OpenView. 
 
In the information below, the installation directory is given as 
C:\OpenView. The installation directory drive is selectable and 
may be different for your installation. 
 
The modifications performed by the installer are as follows. 
The installer will: 
 

1 Edit the file c:\OpenView\conf\oid_to_type.  

2 Edit the file c:\OpenView\conf\oid_to_sym.  

3 Add new .exes and .dlls under c:\OpenView\bin directory. 

4 Add new file xrx_fields under c:\OpenView\fields\C for 
Xerox device specific database fields. 

5 Add new bitmaps for Xerox devices to the 
C:\OpenView\bitmaps\C folder and register them. 

6 Add the new files to the C:\OpenView\symbols\C folder to 
add new Xerox printer device symbol class definitions. 

7 Modify trapd.conf file under C:\OpenView\conf\C, to enable 
CentreWare to log traps received from Xerox devices. 

8 Create the domain Xerox Printers. 

9 Copy the Xerox MIB files to 
C:\OpenView\snmp_mibs\vendor\Xerox and load them. 
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Uninstaller 
 
To run the un-installer, use Add/Remove Programs in the 
Windows Control Panel. The un-installer will remove all files 
copied by the Installer, undo any file changes, and run the 
custom executable XPlugin_Uninstall.exe. This will remove 
the Xerox printer icon, subclass definition, and the alarm object 
corresponding to CentreWare for HP OpenView.  
 
It will additionally: 

1 Remove the lines added to files during installation. 

2 Delete all files copied. 

3 Start services by executing ovstart. 


